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Lectia ].

Recapitulare

v’ Operatii cu principalele obiecte Excel: registre, foi de

calcul, celule

v’ Formatarea datelor si a foilor de calcul, afisarea la

imprimanta

v’ Operatii elementare cu celule, adresarea relativa si

absoluta, formule grafice

Sarcina Revedeti

1 | Creati un nou registru cu numele ,test_initial.xls” New file

2 | Creati trei foi de calcul cu numele ,,sem_1", ,,sem_2" si Rename sheet
,an_scolar”

3 | Grupati cele 3 foi de calcul si scrieti Tn prima linie denumirile | Grupare foi
coloanelor ,,numar_curent’ si ,,nume_si_prenume”,
,,data_nasterii”, ,bursa”

4 | Realizati o serie personalizata cu denumirile obiectelor de Crearea serii
studiu: matematica, informatica, fizica, Ib. romana, etc. personalizate

5 | Copiati seria cu denumirile obiectelor pe linia 1 a tuturor foilor |Introducere serie
de calcul

6 | Pastrati gruparea foilor si introduceti pe coloana Serii numerice
,humar_curent” o serie numerica cu pasul 1 pana la valoarea
30 (presupunem ca in clasa nu sunt mai mult de 30 elevi)
Fixati pentru coloana , data_nasterii” formatul ,,zi numeluna an” |Format data

8 | Formatati coloana ,,bursa” la tipul monetar Lei intreg cu 2 Format currency
zecimale

9 | Formatati coloanele pentru mediile la obiecte la Tntreg fara Format number
zecimale.

10 | Pe ultima coloana puneti ca titlu ,,medie” si formatati la intreg | Format number
cu 2 zecimale

11 | Puneti formula de calcul a mediei fiecarui elev pe coloana Copiere Formula
»,medie”. Copiati-o pe coloana Average

12 | Puneti formula pentru ,,bursa” astfel: daca media este intre 9- |Functiile IF, AND
10 valoarea va fi 100 Lei, daca este intre 7-8.99 valoarea va fi
50 Lei, altfel va fi O Lei

13 | La sfarsitul tabelului addugati o linie si puneti textul ,medii pe |Formatare celule
obiecte” Tn celulele corespunzatoare numarului curent, nume, |de text
data_nasterii pe care le concatenati (lipiti). Centrati textul.
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14 | Scrieti formulele pentru calcularea mediilor la fiecare obiect. | Average
Formatati celulele respective la intreg cu 2 zecimale Format cells

15 |Pe o nouad linie scrieti textul ,total burse” in celulele Sum
corespunzatoare numarului curent, nume, data_nasterii pe care
le concatenati. Centrati textul. Puneti formula pentru suma
totala a burselor. Formatul este bun? Schimbati-I daca e
necesar!

16 |Pregatiti foaia de calcul ,,an_scolar” punand pentru coloana Lucru cu celule
bursa suma bursei din semestrull+semestrul 2 din 2 foi de

calcul; sum

17 |Foaia de calcul ,,an_scolar” va avea n celulele Lucru cu celule
corespunzatoare mediilor pe obiecte media aritmetica cu 2 din 2 foi de
zecimale a mediilor din cele doua semestre. Scrieti formulele. | calcul;
Formatul pentru zona mediilor este corect? Faceti corectia. average

18 |Numiti ,,abs_1" coloana cu absente din foaia ,,sem_1" si Insert>name
»abs_2" coloana cu absentele elevilor din foaia de calcul
,sem_2"

19 |Plasati Tn foaia de calcul ,,an_scolar” o celula cu totalul sum
absentelor pe clasa calculat prin Tnsumarea coloanelor ,,abs_1"
si ,abs_2"

20 |Puneti cate un comentariu la coloanele cu absente din foile de | Insert>comment
calcul ,,sem_1" si ,,sem_2" aratand numele lor si la celula cu
totalul acestora

21 |Salvati cele 3 foi de calcul ca template! Save as template

22 |Introduceti numele a 10 colegi si data_nasterii. Observati Introducere date
prezenta acestor date simultan in cele 3 foi de calcul. n foi grupate
Observati functionarea formulelor.

23 |Separati foile de calcul Degrupare foi

24 |Introduceti valori pentru mediile pe obiecte in semestrul 1 si Introducere date
separat Tn semestrul 2. Verificati functionarea formulelor. Ce se
Tntampla daca nu sunt 30 elevi? Ar trebui schimbate formulele?
De ce?

25 |Pe foaia de calcul ,,an_scolar” inserati o coloana Percentage
»pondere_absente” Tn care veti calcula ponderea numarului de
absente ale fiecarui elev in totalul absentelor clasei.

26 |Pe foaia de calcul ,,an_scolar” inserati o prima linie vida. Insert row
Puneti in celula A1 valoarea unui dolar in lei.

27 |Pe foaia de calcul ,,an_scolar” inserati o noua coloana dupa Adresare
coloana bursa cu valoarea bursei Tn dolari folosind Tn formula | absoluta

adresarea absoluta a ratei de schimb.
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28

Faceti cate o copie pentru fiecare foaie de date

Copiere foaie

29

Mutati toate copiile dupa cele trei foi de date si colorati
numele foilor de calcul (copii) cu rosu

Mutare foi
Format
sheet—>tab color

30

Pregatiti foaia de calcul ,an_scolar(2)” pentru a fi listata la
imprimanta.

Formatare foaie
-delete column

a. stergeti coloana data_nasterii -word art

b. scrieti cu WordArt titlul raportului -format cells

a. ncadrati tabelul intr-un chenar -tools—>gridlines

b. folositi pentru liniile de total fonturi, dimensiuni, culori -insert picture
diferite fata de continutul raportului -background

c. anulati caroiajul -print setup

d. puneti o imagine Tn colful stanga sus -header and

e. puneti ca antet de pagina anul scolar si clasa footer

f. repetati numarul curent al elevului si pe foaia continuare a
mediilor (pentru ca numarul de coloane este mare foaia se
fragmenteaza vertical)

g. Dimensionati paginile astfel incat datele sa fie echilibrat
plasate in pagina. Previzionati.

31 | Pregatiti o foaie — numita ,,centralizator” — pentru tiparirea la | -Copy
imprimanta a unui raport centralizator cu numele, data-nasterii,| -paste special
bursa, absentele si mediile fiecarui elev — fara detalierea pe -autoformat
obiecte.

a. Copiati continuturile tabelelor din fiecare foaie de calcul Print setup
(“sem_1", ,sem_2', ,,an_scolar”) pe verticala unul in Header and footer
continuarea celuilalt, separate doar de o linie pe care scrietil -insert picture
perioada (semestrul 1, semestrul 2 si anual) fara capul de | View Print break
tabel.

b. Puneti ca titlu ,situatia centralizatoare la clasa...”

c. Formatati noul tabel.

d. Pentru ca raportul este mai lung decat dimensiunea paginii,
fixati marginile astfel incat fiecare pagina sa aiba tabelul
dintr-o perioada.

e. Puneti ca antet fotografia clasei.

32 | Pe foaia de calcul ,,an_scolar(2)” realizati graficul mediilor Chart-column
generale pe elev. Atentie! La selectarea seriilor de date din Serie pe coloane
zone neadiacente veti folosi coloana cu numele elevilor si neadiacente
coloana cu mediile generale.

33 | Tipariti la imprimanta graficul mediilor generale pe obiecte — | Chart bar
veti folosi linia cu denumirile obiectelor si linia mediilor Seria pe linii
generale pe obiecte.

34 | Afisati sub forma grafica ponderea absentelor fiecarui elev in Chart pie

total absente pe clasa
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35

Desenati un grafic care sa ilustreze variatia burselor si a Grafice cu 2 serii
numarului de absente pe elev de date

36

Colorati cu rosu situatiile in care un elev are mai mult de 40 de Formatare
absente anual conditionata

37

Tnregistrati temperaturile de dimineata, pranz si seara din mai multe zile. Pe o coloan
vor fi afisate sub forma de imagini fenomenele atmosferice din ziua respectiva: ceata,
senin, vant, zapada, etc. folositi Clip art.

Aflati numarul de zile cand temperaturile de dimineata au fost sub O grade; temperatura
minima seara; temperaturile medii zilnice; temperatura medie a Tntregii perioade si
numarul de zile Tn care temperatura medie a zilei a fost sub cea medie a perioadei.
Afisati sub forma de grafic variatia temperaturilor medii pe zile. Afisati sub forma de
grafic variatia temperaturilor pentru dimineatd, pranz si seara in perioada studiata.

38*

Aflati al 50-lea termen din sirul Fibonacci. Sirul Fibonacci este o serie infinita de numere
intregi O, 1, 1, 2, 3, 5, 8, 13. Primele doua numere sunt O si 1, apoi fiecare numar se
calculeaza ca fiind suma celor doua numere precedente. Aflati de la al catelea termen
se stabilizeaza raportul a doi termeni succesivi. Cat este valoarea raportului de aur?

39*

Mama Tmi spune sa o ajut! Are o retetd pentru 4 persoane. Doreste sa afle cat sa
cumpere din fiecare produs daca la masa vin 10 persoane. Dar daca vin 20?7 Dar daca
reteta ar fi pentru 6 persoane?

latd reteta: ,Se taie rondele 400 g sunculitd frageda de porc, 2 cepe (cca 200 g),
700 g. cartofi fierti, 5 rosii mari (cca “kg); varza alba cam 400 g; 4 ardei grasi (la un
kg intra cam 6 !). Se amesteca bine cu sosul din 3 linguri otet, 2 linguri ulei, sare,
piper. Se presara deasupra branza telemea (cam 200 g). Realizati o foaie de calcul
care sa permita afisarea exacta a cantitatilor necesare unui numar oarecare de invitati.

40*

O firma de comercializare a masinilor de lux a Tnregistrat cantitatile vandute in ultimele
doua luni in regiunile Moldova, Muntenia si Oltenia, Maramures etc. Doreste sa obtina
diferenta cantitativa intre cele doua luni si procentul de modificare a vanzarilor de la
prima luna la urmatoarea. Daca vanzarile au scazut, se va afisa diferenta cu rosu. De
asemenea, doreste sa afle ce procent din totalul vanzarilor au fost vanzarile lunii curente
n fiecare regiune. Realizati foaia de calcul.

41%

Creati o foaie de calcul pentru salariile minime din diferite sectoare de activitate
pentru o tara oarecare. Completati cu date fictive pentru salariile medii din Tnvatamant,
cercetare, armata, politie, sanatate, justitie.

a. Calculati salariul mediu.

b. Aflati procentual ponderea salariului pentru fiecare ramura fata de salariul mediu
general.

c. Adaugati o noua coloana unde veti scrie valoarea salariului Tn dolari. Folositi celula
A1 pentru rata de schimb. Folositi adresarea absoluta. Dati nume celulei si refaceti
formulele pentru calcularea salariului in dolari.

d. Dati domeniului de celule unde sunt trecute salariile numele SAL1.

42*

La firma noastra orice angajat poate iesi la pensie daca a lucrat cel putin 40 de ani
sau are peste 65 ani sau a lucrat cel putin 30 de ani si are peste 60! Afisati pensionarii
posibili.
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Verificarea notiunilor de baza Excel din clasa a X-a

1. S& se creeze un registru de calcul cu numele Facturi.xls care sa contina
doua foi de calcul: Facturi si Situatii. Pe foaia de calcul Facturi creati un tabel
Tncepand din linia 3 cu urmatoarele coloane: data-facturii, numarul-facturii, nume-
furnizor, nume-produs, cantitate, unitate-de-masura, pret de achizitie. Formatati
coloanele la tipul datelor stiind ca preful este in lei cu doud zecimale iar data
este Tn formatul ,nume-luna, ziua, anul”, cantitatea este Tntreaga iar numarul-
facturii este de fapt text! Introduceti 10 linii astfel incat sa fie diferite produse

2. Inserati o prima coloana unde puneti numarul curent ca serie cu pasul 1.

3. Adaugati coloana TVA, unde puneti formula de calcul a valorii TVA pentru
fiecare produs ca fiind cota-tva*pretul de achizitie a fiecarui produs. Cota tva va
fi trecutd ca o valoare in celula Al. Folositi aceasta valoare Tn formula.

4. Puneti in celula A2 cota de adaos practicata de societate ca fiind 30%.
Numiti celula ,cota_adaos”.

5. Adaugati coloana adaos la tabelul initial si puneti formula de calcul a
adaosului ca fiind cota_adaos * preful de achizitie.

6. Adaugati coloana Pret_de_vanzare ca fiind pretul de achizitie + TVA +
adaosul la fiecare produs.

7. Adaugati pe ultimele linii ale raportului o situatie centralizatd unde veti
calcula:
a. Totalul valoric al intrarilor la pretul de achizitie
b. Totalul valoric al intrarilor la pretul de vanzare
c. Totalul valorii tva
d. Totalul valorii adaos

Observatie. Adaugati coloane suplimentare unde sa calculati valoarea la fiecare
linie si sa insumati apoi pe coloana. Coloanele de calcul le veti ascunde.

8. Copiati doar valorile din tabelul facturilor in foaia de calcul Situatie si
pregatiti foaia pentru un raport la imprimanta: puneti titlu, chenare, culori.

9. Realizati graficul variatiei pretului de achizitie si de vanzare la fiecare produs.

1 pct

0,5 pct

0,5 pct

0,5 pct

0,5 pct

0,5 pct

1 pct
1 pct
1 pct
1 pct

0,5 pct

1 pct
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Introducerea si validarea

lectia 2 |istelor Excel

v’ Ce este o lista de date?
v’ Validarea datelor
v" Vizualizarea si editarea datelor prin formulare Excel

O lista de date Excel sau o baza de date! este o colectie de date structurate care se
refera la un obiect distinct dintr-un domeniu dat. Fiecare lista va contine acele atribute
care pot sa caracterizeze obiectul respectiv in vederea memorarii si prelucrarilor specifice
unor utilizatori. De exemplu, Tntr-o listéa necesara examenului de bacalaureat vom retine
pe fiecare linie un elev cu CNP, numele, coala de provenienta, anul cand a absolvit clasa
a 12-a, mediile la fiecare proba. O lista de date pentru dirigintele unei clase poate sa
contina pentru fiecare elev numele parintilor, adresa, hobby, data nasterii, evolutia mediilor
pe obiecte si ani de studiu, etc.

Lista de date Excel apare tot sub forma unui tabel cu linii si coloane. Numai ca fiecare
linie are o anumita semnificatie si, Tn general, fiecare linie are macar o valoare care o
face unica.

De obicei se pune o singura lista pe o foaie de calcul, dar daca sunt mai multe se
separa cu linii si coloane vide. Lista nu trebuie sa contina linii sau coloane vide!

Exemplu:

La balcaniada de informatica de la lasi participa elevi din mai multe tari. Pentru buna
desfasurare fixam ca Tnsotitori ai musafirilor ghizi de-ai nostri. Fiecare elev gazda
numit ghid raspunde de un musafir. Am Tntocmit doua tabele. Observati diferenta!

1 A 8 c A B @ D E
2 LISTA GHIZILOR SI A GHIDUSE LOR
% 1 NUME  VARSTA LOCATIE SEX
5 IONUT 12 ani sala 1 lg—]g)ENEUg :g S:':g: =
6 BEBE 10 ani parter P
7 |ANDREI 10 ani hol 4 |ANDREI 10 hol
8 5 MARIA 10 sala 3 f
9 6 I0ANA 10 parter f
10 MARIA 10 ani SALA2 7 VICA 10 salal f
11 I0ANA 10 ANI PARTER 8
12 VICA 10ani salal o
13
Fig. 2.1. Exemplu de tabel care nu e Fig. 2.2. O lista Excel ocupa o zona
considerat lista n Excel compacta de celule

! Despre baze de date Access ati Tnvdtat Tn clasa a X-a. Revedeti lectiile!
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Coloanele intr-o lista sunt numite campuri. Identificatorul coloanei trebuie sa fie dis-
tinct. Numele coloanelor se mai numesc etichete si se plaseaza pe prima linie a bazei de
date. Spunem ca formeaza structura bazei de date. Liniile se numesc articole sau inregistrari
si formeaza continutul bazei de date.

Daca dorim sa vizualizam etichetele sau numele campurilor, atunci putem folosi chenare
sau culori, dar nu separam structura de continutul listei.

Listele Excel beneficiaza de anumite facilitati, cum ar fi: extensia automata a formatelor
si a formulelor, validarea datelor la introducerea lor sau la o editare, sortarea dupa unul
sau mai multe atribute, filtrarea dupa unul sau mai multe criterii, gruparea si totalizarea
la nivelul fiecarui grup de date etc.

2.1. Extensia automata a formatelor in liste

O facilitate importanta a listelor este extinderea automata a formatului unei coloane
preluand formatul comun a 3 celule (din ultimele 5) anterioare.

Exemplu:

Avem de introdus Tntr-un camp pretul si formatdam doar primele 3 A |

celule ale coloanei la Currency cu doua zecimale si simbolul ,lei”. 1

Introducand n continuare valori pe coloana, chiar daca depasim ) 122 lei

cele 3 celule, observam ca se pastreaza formatul. 3 9 44 ei

Acest lucru este foarte util mai ales cand nu stim de la Tnceput cat 4 SIDD lei

de lungi vor fi coloanele, pentru a le formata de la bun Tnceput. 5 BIDIIII -
. LT N L - 00 lei

Tehnica obisnuitd de a formata intreaga coloana este acceptata G

numai daca pe coloand nu sunt alte categorii de informatii. Excel
aduce ca facilitate preluarea formatului gasit in cel putin 3 din ultimele 5 celule Tn
continuare, pe masura ce introducem datele!

Sarcina 1.

Introduceti valorile urmatoare intr-un camp numit Pret. Formatati celulele [pret
unde se gasesc valorile 2,4,55 la intreg fard zecimale. Addugati pe coloana in 2 89
continuare valorile 5.7A8, 3.7457, 1,9. Ce se Intampla? Ce format vor avea 2
valorile noi introduse? Intreg sau cu 2 zecimale? 4

R. intreg 55
Sarcina 2. 2.6

Observati imaginea. Celulele A2, A4 si A6 sunt formatate la valori A
monetare cu doua zecimale, iar celulele A3 si Ab la intreg. Ce format | 1
va avea valoarea din celula A7? Dar A8? 2 1.22 lei

Cum procedam sa schimbam formatul la numeric (intreg) pentru | 3 2
celulele care urmeaza lui A7? Dar la text? 4 5.00 lei

5 B
B 9.00 lei
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2.2. Extensia automata a formulelor in liste

O altad facilitate a bazelor de date este extensia formulelor, daca toate celulele
precedente (cel putin 4!) au aceeasi formula.

Exemplu:
Avem de introdus si de calculat mediile anuale TN TTE 5 = 3
ale mai multor elevi. Desigur, pentru primul vom | !

. . . o 2 cod medial  media2  media_general
scrie formula si o vom copia pe coloana. Ce ne |3 1000 500 750
facem Tnsd daca nu avem date? Mesajul de eroare | T 2
afisat datorat lipsei de date poate sda ne |& 700 800 7.50
incomodeze. Unii proiectanti ai foilor de calcul |] ey
folosesc formatarea conditionata pentru ca eroarea | @ 7N

. o s e - o 10 #ONVOI
de acest tip sa fie invizibila. O facilitate oferita de |, " oAl
Excel este ca, odatd formula repetatd pe 4 celule U2 _#ovm

anterioare ale coloanei, se copiaza automat in
noua linie atunci cand introducem valorile de calcul, fara ca operatorul sa aiba grija
de acest lucru. Si fara ca foaia de calcul sa fie invadata de mesaje!

Sarcini de laborator

1. Refaceti exemplul nostru. Puneti formula pe prima celula si copiati-o doar pe 4
celule. Introduceti valori in continuare pe cel putin 6 randuri. Observati refacerea automata
a formulei.

2. Construiti un nou registru cu numele Balcaniada, in care pe foaia de calcul ,,ghizi”
proiectati structura unei baze de date cu urmatoarele campuri: numele ghidului, varsta,
scoala, sex, sala de care raspunde, numele musafirului, varsta acestuia, tara, sex, disciplina
de concurs, data_sosirii

2.3. Validarea datelor

Introducerea datelor trebuie sa se faca corect inca de la introducerea datelor. Nu avem
de ce sa pierdem timp pentru a verifica corectitudinea datelor dupa ce actiunea de
introducere sau editare a fost terminata la toata lista! De aceea se poate specifica o
anumita conditie pe care trebuie sa o indeplineasca valorile la intrare.

La introducerea unei valori eronate operatorul poate fi doar avertizat ca s-a produs o
abatere fatd de valoarea consideratd buna dar i se permite sa continue procesul de intrare.

Sunt situatii, Tnsa, Tn care operatorul trebuie oprit la aceeasi celula pana la introducerea
valorii corecte.

Fixarea sau anularea regulilor de validare, mesajele catre operator la introducere si/
sau mesajele de eroare se stabilesc prin fereastra de dialog deschisda de comanda
Data->Validation.

Anularea validarii se face prin aceeasi fereastra de dialog prin butonul Clear.
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Cateva observatii

E necesar ca Tnainte de deschiderea ferestrei de dialog sa ne pozitionam pe campul
unde dorim introducerea restrictiilor de editare.

Daca nu stim cat de lunga va fi coloana, o vom selecta in intregime si, dupa fixarea
conditiilor de validare si verificarea lor, vom anula validarea pentru eticheta campului
prin butonul Clear din fereastra Data—>Validation.

Vom exemplifica cateva tipuri de validare pe o baza de date despre ghizi construita in
foaia numita ,,Ghizi” din registrul ,,Balcaniada” cu structura: nume_ghid, varsta, sex,
locatia, scoala, nume_musafir, tara, varsta_musafir, sex, disciplina de concurs etc.

2.3.1. Validarea numerelor prin limitarea valorii

Exemplul 1

Pentru lista elevilor care sunt
ghizi la Balcaniada varsta poate A g L o E F &
fi —de regulda —intre 7 si 15 ani,

dar se admit si exceptii. Deci [l MWHE WARSTA

3ot [ 6 Micresoll bxcel

daca un elev are varstade 16 ani, |3 geee i
o o~ abentie varsta ghizlor ar trebul sa fie intre 7210 ani
operatorul este cel care va hotarl | 4 ANDREI 10 ﬂ
% 1% g e
dacd acceptd sau nu persoana |2 MARE 10 S
e oA . B 108N 10 o ] = ol
respectiva. Observati Tn imagine |7 yica 10 z |l

mesajul afisat atunci cand am |8
introdus o valoare eronata. 19u
Cum procedam?

Fig. 2.3. Validare cu avertizare

Pasul 1. Selectam coloana B.
Pasul 2. Deschidem fereastra de validare cu Data->Validation.

Pasul 3. La pagina Settings fixam tipul de data Decimal si operatorul Be-

Settings ] Input

Walidation critetia

allow: tween

Dec‘f“a' Pasul 4. Introducem limita inferioara 7 si limita superioara 15.

Q:::,@T Pasul 5. La pagina Error Alert alegem stilul alertei Warning si scriem textul
Winimur mesajului afisat in caz de eroare.

7 Pasul 6. Pentru c& prima celuld B1

Mazximurn:

IE— contine n.umele coloar}ei VOM  |ssttings | InputMessags  Error Alert |
anU|a Valldarea acestei Ce|U|e I¥ Show errar alert after invalid data is entered

Flg 2.4. pOZ”_;lOné n d cursoru | pe aceasta §| hen user enters invalid data, show this error alert:
Fixarea actionand butonul Clear din ?ﬁiimﬂ“&
conditiei fereastra Data->Validation -
Efrar message:
3 atentie varsta ghizior ar trebui sa fie intre 7-
L] 10 ani

Fig. 2.5. Fixarea stilului si @ mesajului

LEC]’IA 2 ® INTRODUCEREA $!1 VALIDAREA LISTELOR ExceL




2.3.2. Validarea textelor prin selectarea unei valori (lista derulanta)

Exemplul 2

Tn lista ghizilor pe care am construit-o in aceasta lectie considerdm c& locatia trebuie
s& fie doar una din valorile ,,sala 1, sala 2, sala 3, parter, hol”. Tn acest caz nu se va
permite introducerea altei valori decat cea din lista! Operatorul va fi oprit din editare si
fortat sa reintroduca valoare pana cand valoarea corecta (butonul Retry).

Observati imaginea capturata

Cum am procedat?
Pasul 1. Am selectat coloana C

Pasul 2. Am deschis fereastra
Data—>Validation A B € D E F G

Pasul 3. Am fixat pentru valoa-
1 |MUME WARSTA LOCATIE SEX

rea coloanei tipul List gi am |5 onur Bleael o
construit lista direct Tn zona de |3 BEEE 10 parter  m -
H 4 ANDREI 10 hal m Microsoft Excel
editare Source. AR o
Pasu' 4- Pentru S|tuat|a Tn care EJ‘\E:QEA :]]gr%fvl @ alegeti sala dintre valotile datel
valoarea este eronata am intro- & i

. A w . 9
dus oprirea pana la introduce- |

rea valorii corecte prin stilul

Fig. 2.6. Validare cu oprire

alertei: stop!

Data Validation Data Validation

| Input Message | Errar &lert l Settings ] Inpuk Message  Error Alert l
Walidation criteria Iv Show error alert after invalid data is entered
Allow: ‘When user enters invalid data, show this error slert:
List - v Ignaore blank Style: Title:
Data: v In-cell dropdowin Stop |
Etror message:

Source: @ alegeti sala dintre valorile date! |
|sala 1; sala 2; sala 3; parter 1[

Fig. 2.7. Construirea unei liste de valori Fig. 2.8. Fixarea mesajului si a stilului pentru

situatia de eroare

Exemplul 3

Sa presupunem ca in baza de date a elevilor ghizi introducem un nou | scoala
camp Scoala. In aceastad coloana validarea se va face prin preluarea || v
; H o3 ; 3 5C. Genn S iasi
vanr|IorAd|ntrv—o lista, darvse va accepta si o noud yalqarve —deexemplu | |0 connr. 4 s
un elev invata la o scoala care nu a fost trecuta in lista! lic. Informatica i
% % ; ; ; : : Colegiul Negruz]
Sa presupunem cd avem deja scrise numele scolilor din lagi pe care | |\ iona jasi

le-am putea folosi. Sunt doua situatii:
a. valorile sunt 7n aceeasi foaie de calcul cu baza de date pe care
dorim sa o validam, caz n care folosim referintele la zona
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Data ¥alidation

} Input Message ] Error Alert

| Validation criteria

Allans:

|List Ea
Daka:

| [
Source:

|=scoli

Fig. 2.9. Lista derulanta se afla in
domeniul cu numele ,,scoli”

Exemplul 4

Tn registrul de lucru ,Balcaniada” avem o
baza de date cu ghizii si elevii participanti.
Dorim sa introducem numele disciplinei la
care concureaza fiecare participant printr-o
lista (dropdown list). Stim ca n registrul
»inspectorat” exista o baza de date cu disci-
pline de concurs, pe care am putea sa o
folosim.

Cum facem?

Metoda nu difera prea mult de folosirea pentru
lista derulantda a unui domeniu cu nume,

prin Windows—>Arrange.

Tntr-o listd Excel.

Data Validation

Walidation criteria

Inpuk Message ] Error flerk

Bllone;

[List |
Daka:

| El
Source:

[=fag102:524107

Fig. 2.10. Lista derulanta este un

domeniu Tn aceeasi foa
calcul

ie de

b. numele distincte ale scolilor din oras se gasesc pe alta foaie de calcul si atunci
vom da nume coloanei — atentie fara eticheta de camp — si vom pune Tn campul
Source numele zonei, precedat de semnul =.

El balcaniada

E

—_

discipline_de_
CONCurs
algoritrmi

haze de date
weh

TIC

maternatica
cercetari operational

OO0 g O P DD

disciEIina
w

algoritmi

baze de date
weh

TIC

makematica
cercekari operat]

OO~ | O | (T e L || —

Fig. 2.11. Lista derulanta cu valori

din alt registru

numai ca de asta data va trebui sa fie o referinta externa.

Pasul 1. Deschidem registrul ,,balcaniada” prin File=>0pen.

Pasul 2. Configuram fereastra Excel astel incat ambele registre sa fie deschise simultan

Pasul 3. Ne pozitionam in foaia de calcul unde avem campul ,,Discipline_de_concurs”.
Verificam ca valorile pe care le vom folosi pentru lista de validare sa fie constituite
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Pasul 4. Prin Insert>Name—>Define vom da numele ,,disciplina”, iar in zona de editare
Refers to... stergem referinta existenta si prin conturare cu mouse-ul introducem
referintele coloanei discipline_de_concurs din registrul ,inspectorat” care este activ!

Pasul 5. In fereastra Define Name ad&ugam noul nume.

Pasul 6. Selectam registrul ,,balcaniada” si ne
pozitionam pe celula unde dorim introducerea
validarii prin lista (derulantd).

Pasul 7. Deschidem fereastra de validare prin
Data->Validation introducem numele dome-
niului (creat ca referintd externa!) precedat de
semnul =. Vezi captura alaturata.

Atentie! Nu uitam ca la operatiile de editare a
bazei ,participanti” registrul ,,inspectorat” sa
fie deschis!

Sarcini

Data Validation

Settings l Input Message ] Errar Alert I

Walidation criteria

Allow:

|List j I+ Ignore
Data: v In-cell
Source:

|=disciplina E

Fig. 2.12. Validare prin apartenenta la o
lista din alt registru

1. Addugati in baza de date ,participanti” o noud coloana pentru tara de origine a

fiecarui musafir si fixati ca validare apartenenta
validare prin:

a. introducerea directa a constantelor;

b. preluarea valorilor din domeniul AA1:AA20

la o lista de valori. Construiti lista de

a aceleiasi foi;

c. preluarea valorilor in domeniul A1:A20 a altei foi de calcul;
d. preluarea valorilor din alt registru constituit de voi.

2.3.3. Validarea prin

compararea continuturilor celulelor vecine

Exemplul 5
In baza de date ,ghizi” A B © H J
introducem o noua coloana
pentru campul varsta_musa- | 1 NUME  WARSTA LOCATIVARSTA_MUSAFIR
fir alaturi de numele musa- | 2 AMDREI 10 hel J
firului | 3 |BEEE 10 parter | 27]
N . . 4 |IDANA, 10 parta
Vom fixa ca validare condi- | 5 jonuT TIPS BALCANIADA
tia ca varsta ghidului sa fie | & wiCA 10 sal
mai mare decéat cea a musa- ; MARIA 10 sal y FIT ATEMT LA DIFERENTA DE VARSTA!
firului! g

L] 4

Fig. 2.13. Validare cu informarea operatorului asupra valorii

eronate
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Cum procedam?

Pasul 1. Pe prima valoare care trebuie validata se introduce conditia de validare,
precedatd de semnul egal. Pentru ca varsta primului musafir se afla in celula H2, o
vom compara cu varsta ghidului din celula B2. Observati datele din baza de date si
construirea conditiei.

Pasul 2. Fixam mesajul si stilul avertizarii in caz de eroare
Pasul 3. Verificam functionarea validarii Tn celula H2
Pasul 4. Copiem validarea pe coloana folosind comenzile Copy si Paste Special.

Observatie: Odata cu operatia de copiere a validarii in celula H3, expresia devine
B3>H3, in celula H4 devine B4>H4 s.a.m.d. (datorita folosirii adreselor relative!).

Sarcini de laborator

1. Creati o alta foaie de calcul in registrul

Balcaniada in care proiectati baza de date concurs s aae
. . . Nl Data Validation
cu structura cod-participant si punctele obtinute n

fiecare zi de concurs. l Inpuk Message l Error Alert l
2. Validati punctajul obtinut in ziua 1 astfel incat B
sa fie mai mare ca 1 si mai mic ca 100. Yalidation criteria
3. Validati punctajul obtinut in ziua 2 astfel incat Allav:
sa fie cel putin egal cu cel din ziua 1, altfel celula |_Custc:m j
ramanand fara continut.
4. Tn baza ,ghizi” puneti coloana Data-sosirii Data:
pe care sa o validati astfel Tncat valoarea introdusa | J
sa fie mai mica decat data curenta primita de la Farmula:
sistem. ezt

Fig. 2.14. Validare prin referire relativa

Data Yalidation la o celuld vecini

I Input Message ] Error Alert ]
Walidation criberia . . . . .
! Fig. 2.15. Validarea unei date calendaristice si
=l folosirea functiilor
|Date ﬂ v
| Data: Exemplu. Tn coloana Data_sosiri dorim validare astfel
incat valoarea introdusa sa fie mai mica decat data
|Iess than j <
curenta.
End date: Observati fereastra de validare. Operatorul este ,,less
|=TCDaT ]| than” iar functia care intoarce data sistem este To-
day().
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2.3.4. Marcarea celulelor invalide

Am Tnvatat ca mecanismul de validare este declansat la terminarea introducerii unei
valori Tntr-o celuld. Operatorul este solicitat sa introduca valoarea corecta. Sa luam in
discutie cazul in care validarea unei valori depinde de valoarea dintr-o celula anterioara.
Ce se intampla, insd, daca dupa ce s-a terminat actiunea de introducere a valorii validate
se modifica valoarea Tn celula de referinta? Atunci mecanismul de validare nu mai este
declansat si ramane valoarea introdusa eronat.

Cum aflam daca sunt astfel de situatii?
Prin Tncercuirea cu rosu a celulelor care au valori eronate. Aceasta operatie se realizeaza
prin Tools>Formula Auditing—>Show Formula Auditing Toolbar si butonul Circle invalid Data.

Exemplul 6
Avem de introdus valori numerice Tn coloanele K, L, M,
cu urmatoarele restrictii:
a. Valorile din coloana K trebuie sa fie mai mici ca 20;
b. Valorile din coloana L trebuie sa fie mai mari decéat
cele n coloana K; ; f
c. Valorile din coloana M trebuie sa fie mai mari decat | 3 6
4
5

suma celorlalte doua.

Pasul 1. Am pus conditiile de validare astfel:

a. pentru celula K2 tipul este Decimal, operatorul este Less than, iar la maximum am
pus valoarea 20;

b. pentru celula L2 tipul este Custom si formula este =(L2>K2);

c. pentru celula M2 tipul este Custom si conditia este = (M2>(L2+K2).

Tools | Data  Window  Help

Track Changes oo | T HE s - B4

Probection 3

Formula Auditing » || 3= Trace Frecedents

[Macra b |=F  Trace Dependents

Pasul 2. Am copiat celulele K2, L2 si
M2 pe coloanele lor.

Pasul 3. Am introdus valori si am verificat
validarea. In acest moment, datele sunt
corecte.

Customize. .. Trace Error

b &

Remave All Arrows

Dpkions...

¥

Show Formula Auditing Toolbar

Pasul 4. Modificam valoarea K3=12 si
K4=16. Dorim sa stim daca validarile
mai sunt corecte!

Pasul 5. Deschidem Tools—=>Formula Audi-
ting—>Show Formula Auditing Toolbar si
activam butonul Circle invalid Data

i —  __ Observam ca datele incorecte sunt incer-
Fig. 2.16. Marcarea celulelor invalide prin Circle . ite cu rosu!

Invalid Data de pe Formula Auditing Toolbar

TEHNOLOGIA INFORMATIEI §1 A COMUNICATIILOR ® CLASA A XI-A




Sarcini

1. Adaugati la lista participantilor din registrul Balcaniada coloana ,,bursd”, in format
Currency fara zecimale, cu valoarea monetara $, care sa primeasca doar valori pozitive.

2. Addugati o coloana , taxe_si_cheltuieli” cu acelasi format, dar care sa primeasca —
de reguld — o valoare mai mica decat 1/2 din valoarea bursei.

3. Introduceti 5 valori si verificati functionarea validarilor.

4. Modificati acum pe coloana ,,burse” valoarea astfel Tncat, uneori, s@ nu se mai
respecte conditia din coloana , Taxe_si_cheltuieli”

5. Marcati cu rosu celulele cu valori eronate!

2.3.5 Atentionarea operatorului prin mesaje de intampinare

De multe ori operatorul nu stie ce valori sunt considerate corecte sau ce trebuie sa
introduca ntr-o celula. De aceea sunt utile mesajele care se afiseaza Tnaintea selectarii
unei celule.

De exemplu, dorim ca numele elevului sa fie scris cu majuscule si informam despre
acest lucru pe operator.

£l balcaniada

HUME WARSTA

1
scricti 1 Fig. 2.17. Mesajul de intampinare se compune tot prin fereastra de
numele cu 1 validare deschisa prin Data->Validation in pagina Input Message.
majuscule ! 1 Aveti grija ca sa fie activ comutatorul Show input.

2.4. Vizualizarea si editarea datelor din liste prin
formulare Excel

Atunci cand listele pe care le construim in Excel sunt foarte mari, cu multe coloane si
multe linii, operatorul care doreste sa adauge un nou articol nu mai vede nici denumirea
campurilor (antetul este pe prima linie!) nici toate coloanele. O modalitate de a aduce in
zona vizibild datele Tndepartate este tehnica Split. O alta modalitate este folosirea
formularului Excel.

Formularul asociat listei se deschide prin meniul Data->Form.

Un formular(form) prezinta doar un singur articol, avand pentru fiecare camp denumirea
si valoarea sa care poate fi vizualizatd? si/sau editatd. Dacd numarul de campuri este

2 Depinde de protectia aplicata la nivel de celuld, foaie, registru. vezi , Protectia datelor”.
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prea mare pentru a putea fi incluse in 7 U
ferestra formularului, putem sa ne P ghizi (3) @E
deplasam cu bara de deplasare verticala. ||
Putem s& vedem datele prin deplasare NUIME: - Lofé
catre inceputul listei (butonul Find Prev) LOCATIE: et New
sau catre sfarsit (butonul Find Next).
Putem ad&uga noi linii (butonul New) aEx: m _ Dekte |
sau putem sa stergem linia curenta MUSAFIR MUME:  |Beatrice
(butonul Delete). MusaFIR vaRsTa: [0
Firnd Prew
MUSAFIR SEx: f
Find Mext
TARA: Bulgaria [ Fneess
. Criteria
.. 1Problema 1: |10 o =R
Sarcini de laborator = e
1. Deschideti un formular pentru baza dlproplemaz: |z Close
de.date »ghizi” si adaugati inca 4 noi Fig, 2.18. Formularul asociat listei penrtu
articole. vizualizarea si editarea datelor

2. Verificati daca validarile functio-
neaza si la nivelul formularului

3. Pozitionati-va pe articolul 2 si stergeti-I.

4. Restaurati datele. Se poate anula operatia de stergere prin formular a unui articol?

5. Pozitionati-va pe primul articol si modificati numele ghidului.

6. Deplasati-va la articolul cu numarul 3.

7. Apasati butonul Restore si revedeti articolul 1. S-a pastrat corectia voastra? Sau
s-a anulat?

8. Problema

La firma Imobexpert, care se ocupa cu tranzactii imobiliare, se inregistreaza ofertele
de vanzare si cererile de cumparare a apartamentelor, caselor, terenurilor. Pentru fiecare
client se inregistreaza si datele personale (nume, telefon, e-mail) pentru a putea fi contactat
n cazul in care au fost gasite solutii pentru cererea sa. Proiectati bazele de date imaginand
cererile de informatii. Ce informatii ar solicita un client? Dar un sef? Poate o lista cu
ofertele/cererile dintr-o zona, ordonate dupa pret, poate o listd a apartamentelor cu x
numar de camere si cu pretul cel mai mic. Poate o lista a apartamentelor pe zone sau
dupa preturi, separat vanzarile si separat cererile de cumparare? O situatie statistica a
numarului de apartamente deja vandute si comisionul aferent pe luni/ani. O situatie a
cererilor comparativ cu ofertele de terenuri etc.

[y, ¢

(Test 1 %

Se va verifica nivelul cunostintelor si al deprinderilor de operare cu tipuri de date
diferite, introducerea si validarea lor.
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